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The new LA GARD 700 Series Safe Locks consolidate
multiple input units down to a few.

Input units options now include: display, bluetooth,
and extended battery life.
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700 Series
Model: 700 Basic Specs

e
Model 700 Basic

OLED Display Keypad

No

Compatible Lock Types

Swingbolt/Deadbolt

# of Users 1Manager/1User
# of Locks 1
Super Master Reset Code Yes
Dual-User Mode No
Dual-User Mode Override No
Reset Function Yes
Time Delay No
Confirmation Window No
Time Delay Override (TDO) No
TDO with BLE FOB No
Programmable @ Keypad Yes
Programmable @ PC No
Audit Events No
Viewable Audit Trail No
Downloadable Audit Trail No
Duress Alarm No
Combination Length 6 Digits
Back Lit Keypad Yes
Bolt Switch Option* No
Wrong Try Penalty Yes
Battery Power 2x 9V
Low Battery Warning Yes
Critical Low Battery Warning Yes
AC Power Option Yes
Low-Profile Keypad No
Time Lock Schedule No
Dual Credential No
UL 2058 - UL Type 1 Yes
VdS 2396 - Class 2 Yes
EN1300 - Level B Yes
SBSC -3880:2015 Pending
CNPP a2p - Level B/E Pending

Warranty

2 yr fromm DOM

Updatable Firmware

Yes
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LA GARD /00 Series

Frequently Asked Questions |
Model 700 Basic | 7 8

4GHI 5JKL

1. Can all keypads and locks be interchangeable/paired together?
A. The 700 Basic Keypad and locks are not compatible with any of the other 700 Series locks or keypads.

2. Does the 700 Basic keypad come with a display?
A. No

3. What type of 700 Basic locks do you offer?
A. Swing Bolt, Dead Bolt

4, What Spindle options are available with the 700 Basic Dead Bolt ?

A. Select the appropriate Spindle for your need.
We offer:
- Default for Dead Bolt 1.37"
-1.37" x M4, drilled and tapped
-1.37" x 10-32, drilled and tapped
-2.37"
-1.85"

5. Does the keypad come in low profile?
A. No

6. Where should the keypad cable be plugged in on the lock body?
A. ENT (Entry) Port

7. Can you mute the audible keystrokes?
A. No

8. How can | tell which model keypad | have?

A. ldentify an installed LA GARD Basic Lock by pressing # on the keypad. 700 Basic Keypads will illuminate the
backlight feature but will not respond to this command.
Note: Keypad Models 701-705 wiill respond with a green LED.

9. Do you offer a warranty?

A. 2 years from date of manufacture

10. What color options do you offer for the 700 Basic?
A. Black and Satin Chrome/Black



11. What type of batteries does the 700 Basic keypad take?

A. The battery box and tray fit 2-9V Alkaline Batteries
Though not recommended, the system can operate with 1-9V Battery

12. Does the 700 Basic have a low battery warning?
It is recommended to change batteries once a year. Use only high quality 9 volt Alkaline batteries.

Low Battery Warning - Keypad will repeat signal 5 times during lock opening. (- % x5
This warning indicates that the battery is low and should be replaced.

Critical Low Battery Warning - Keypad respond to any key press by repeating this signal 10 times - % x10
This warning indicates that the lock cannot be safely operated. The batteries must be replaced before the lock

will operate.

13. How do | wake the lock?
A. This is not required for the 700 Basic Lock.

14. What certifications does the 700 Series have?

A. UL

B. Vds

C.UKCA

D. EN1300

E. A2P - Pending

F. ECB-S - Pending
G.CE

H. SBSC - Pending

15. Is the 700 Basic Keypad or Lock compatible with Legacy LA GARD Products?
A. All 700 Series Keypads and Locks are incompatible with legacy LA GARD

16. Is the 700 Basic Keypad or Lock compatible with other 700 Series Models?
A. The 700 Basic Keypad and Locks are not compatible with other 700 Series Models.

17. Do the current accessories work with the new 700 Series?

A. No, there is a new set of accessories for the 700 Series you will find below:
Item Part Number:
704065: 700 Series Reset Box
704055: 700 Series Battery Box
707040: USB Dongle
203325: USB to Micro-USB Cable
701107: AC-Power Supply Multi-Adapter
701131: AC Power Supply 16 foot

18. Can | program my lock with the LA GARD software?
A.No

19. How do | update the firmware for my 700 Basic Keypads and Locks?

A. The latest Firmware is available at no additional cost through the free version of our 700 Series Software and
the USB Cable (203325) and USB Dongle (707040) can be used to update your keypads or locks.

20. The LA GARD Software password is not working, is there any way to reset it?
A. No but the default is LAGARD

21. Does the software need to be license on each computer?

A. Yes even the free software does require user registration.



22. How many locks per license?

Part Number Maximum Locks Managed Comment
700068: 100 Maximum Per Database

700069: 250 Maximum Per Database

700074: 1000 Maximum Per Database

23. Why is my lock is not connecting to the software?

A. Make sure you have a USB dongle to connect to the software

24. Why is my USB dongle not showing up in device manager?

A. Need to install the USB drivers:
Go to https://ftdichip.com/drivers/d2xx-drivers to download the drivers

25. How do | get a copy of the latest 700 Series software or firmware?

A. The new software and firmware versions are requested from the website just like when the software was
first acquired:

https://www.dormakaba.com/us-en/knowledge-center/la-gard-software-download/la-gard-700-series-
software-download

26. How do | upgrade my software?

A. Install the new 700 Series Software as an administrator. The existing version does not need to be removed
first. All your data is retained.

27. How do | upgrade the firmware in my lock and keypad?

A. Firmware Upgrade:

When a new firmware is available, these files will be available to LA GARD Software users. Using the LA GARD Software

client, keypad and lock firmware can be updated. To update the Lock and Keypad Firmware to the current version, the

Manager user will require a PC with 700 Series Software, a 700 Series USB Dongle (PN 7047040), and a USB to Mini

USB Cable (PN 203325).

1. Connect the Keypad to the PC. Plug the 700 Series USB Dongle into the USB Port of the PC. Plug the USP port of the
cable into the dongle. Then plug the mini-USB into the port on the lock Keypad.

2. Enter the Manager Combination and hold the last digit for 3 seconds " -/ 2 _ED remains on.

3.Press 6. (o4 LED remains on.

Note: The unit is in Firmware Load Mode for about 60 seconds. During this period, the unit will ignore any inputs from
the keypad to allow communication between the software and the unit.

4, Use the software to select and upload the latest 700 BASIC firmware file. LED remains on until connection is
established. If no connection is established within 60 seconds, it will time out and the LED wiill turn off. Once the
connection is established, the keypad LED will blink green throughout the entire update process.

5. The Keypad LED will stop flashing green to signal that the firmware update is complete.

Note: 700 Basic Locks and Keypads are only compatible with 700 Basic Firmware. 700 Basic firmware is not compatible
with other 700 series models. If an incompatible firmware is chosen, the 700 Series software will display an error and

maintain the connection until the compatible firmware is selected. To clear the error, select the appropriate firmware and
complete the update.

If an incompatible command is selected, the lock may respond with a Red LED that may remain on for up to 20 seconds.
During that time the keypad will not respond to key presses.

28. | tried to upgrade my Lock/Keypad's firmware and the Keypad is unresponsive while displaying Lock 1boot and
F/W update. What is this and how can | fix it?

A. This happens when the firmware update is interrupted, and the keypad is stuck in the firmware update mode.
This can be fixed by doing the following:
« If the lock is not attached to a multiplexer:
Connect the keypad to the PC and resend the firmware from the software
« If the lock is attached to a multiplexer:
Disconnect the lock and keypad from the multiplexer and connect the lock to



Updated Operating Instruction

LA GARD 700 Basic

Operating Instructions
Dual-Handed Swing Bolt or Deadbolt

Compatibility and Identification

« 700 Basic Keypads and Locks are not Compatible with 700 Series or LA GARD Legacy Locks and Keypads.
« 700 Basic Keypads and Locks are compatible with these 700 Series Software and these 700 Series Accessories:
— 700 Series Reset Box (Part Number 704065)
— 700 Series AC-Power Supply (Part Number 701131)
— 700 Series Software for Firmware Update Only
— 700 Series USB Dongle (Part Number 707040)
— 700 Series USB to MiniOUSB Cable (Part Number 203325)

+ ldentify an installed LA GARD Basic Lock by pressing # on the keypad. 700 Basic Keypads will illuminate the backlight feature
but will not respond to this command.

Note: Keypad Models 701-705 will respond with a green LED

User Operations

User Operations Super Master Reset Code (Optional) Manager User
Reset Lock Yes No No
Open Lock No Yes Yes
Change Own Combination & Yes Yes
Enable/Reinstate User No Yes No
Disable User No Yes No
Delete User No Yes No
Firmware Update (Requires No Yes No

Connection to 700 Series Software)

“*Super Master Reset Code Must be changed from default prior to changing the Manager Combination. This is the only opportunity
to set the code. Once set, it cannot be changed. If it is not set at this time, the Super Master Reset function will not be available.

Lock Operating and Navigation

« To Open alock, Enter 6 Digit Combination.

» Lock must be opened within 4 seconds of entering a valid combination.

« To open a container with a Swing Bolt Lock, turn the container handle to the open position and open the door.
« To open container with a Dead Bolt Lock, turn the keypad or dial to retract the bolt and open the door.

« When closing a container, verify that it has been secured.

- Toenter alock operation command, enter the 6-digit combination and hold the last digit for 3 seconds until the keypad
responds with (% and the LED will remains on.

« If a mistake is made while entering a combination or command, wait thirty seconds and repeat the operation.
+ A Double Signal “indicates that the combination or command valid and accepted.
« A Triple Signal " Zindicates that the combination or command is invalid.

« Super Master Reset Code (SMR) must be changed from the default 55555555 before the Manager Combination is changed or
the SMR option will be unavailable. Once the Super Master Reset Code has been set it cannot be changed unless the lock is
reset using a compatible Reset Box.



Installation

Refer to the LA GARD 700 Series Quick Start Guide or Safe Lock Installation Guide for mounting instructions. The lock should be
mounted and connected to the keypad before applying power or inserting batteries.

1. Mount the Keypad.

2. Mount the Lock.

3. Connect the keypad to the ENT port of the lock.

4. Add batteries or connect to power. The lock will respond to confirm that it is ready for operation. )

Note: If the keypad is connected to power and no lock is detected within 10 seconds, the keypad will give an error signal x5

Once the lock and keypad connection is corrected, the keypad will confirm that it is ready for operation. %) Press any number
key to check connection again.

Quick Start: 1 Manager/1 User/Super Master Reset Code

Perform all Programming with the container door open. Test each user combination before closing container.

1. Change Super Master Reset Code Press and hold O for 3 seconds (% Super Master Reset Code
(Optional) Enter the default code 55555555 and hold the last digit for is available for use
3seconds (% (% LED will remain lit.
Press O (%

Enter new 8-digit code (%

Re-enter new 8-digit code -
LED will turn off
2. Change Combination Open container Manager combination is
(Recommended) Enter 000000 ()% changed
Enter default combination 123456 ‘:?‘:3
LED will remain lit.
Enter new combination (ex. 654321) ’
Re-enter new combination (ex. 654321) - s
Test combination before closing container
LED will turn off

3. Enable User - Command 1 Enter new manager combination and hold the last digit for New user is active with
(Optional) 3seconds (- (< LED will remain lit. combination
Press1 %

Enter new user combination (%
Re-enter new user combination ®s
Test combination

LED will turn off

Lock Operations

Operation Action Requirement Result
Set Super Master Bress erd Melldl 0 Far 2 secends (8 Set up operation. Super Master Reset Code is
Reset Code Enter the default code 55555555 and hold the last digit Must be done before the available for use.

for 3 seconds (L (L2 LED will remain lit Manager changes their code.

Press O (.

Enter new 8-digit code (-

Re-enter new 8-digit code %
LED will turn off

Open Lock Enter active combination (% Manager or user Lock is opened. Within 4
Open container seconds, the bolt can be
retracted.




Change
Combination

It is recommended to perform this operation with the
container open.

Method 1:

Enter 000000 (%

Enter existing combination (ex. 123456) % LED will
remain lit.

Enter new combination (ex. 654321) ‘C‘:ﬁ

Re-enter new combination (ex. 654321) @3

LED will turn off

OR

Method 2:

Enter existing combination (ex. 123456). Hold the last
digit for 3 seconds ®: E
Press O

Enter new combination (ex. 654321) C}:‘;

Re-enter new combination (ex. 654321) ()%
LED will turn off

(% LED will remain lit.

It is recommended to test combination before
closing container.

Manager or user

Combination is changed.

Enable User Enter Manager Combination and hold the last digit for  Manager New User is active with
Command 1 3seconds % ("% LED will remain lit. combination.
Press1 (.4
Enter new user combination (-
Re-enter new user combination (t]:l’;
Test combination
LED will turn off
Reinstate User Enter manager combination and hold the last digit for ~ Manager Disabled User is active with
Command 1 B cmeands 0 (08 LED willl rermetin e existing combination.
Press1 (%
LED will turn off
Disable User Enter Manager Combination hold the last digit for 3 Manager User is disabled.
Command 2 seconds (% (% LED will remain Lit Combination is retained but
Press2 (-5 not active.
LED will turn off
Delete User Enter Manager Combination and hold the last digit for Manager User is deleted.

Command 3

3seconds (% (0% LED will remain lit
Ao

Press 3 (&)«

LED will turn off

Combination is deleted.

Reset Lock with
Super Master Reset
Code

o

Press and Hold O for 3 seconds :‘:m

digit for 3 seconds @s O
Press8 (.1
LED will turn off

Super Master Reset Code
must be set.

Super Master Code remains
the same. Manager
combination is 123456. No
user combination exists.




Other Features

Wrong Try Penalty
Entry of 4 Consecutive invalid combinations initiates a 5-minute delay penalty.
During this penalty period:
» Keypad LED will flash every 10 seconds.
» Keypad will not respond to use of number keys.
After 5-minute delay, 2 consecutive invalid combinations will initiate another 5-minute penalty period.
This will continue until a valid combination is entered.

Low Battery/Battery Replacement
It is recommended to change batteries once a year. Use only high quality ?-volt Alkaline batteries.
Low Battery Warning - Keypad will repeat signal 5 times during lock opening. /€ x5
This warning indicates that the battery is low and should be replaced. a
Critical Low Battery Warning - Keypad respond to any key press by repeating this signal 10 times (/% x10
This warning indicates that the lock cannot be safely operated. The batteries must be replaced before the lock will operate.

Mechanical Reset with Reset Box
A mechanical reset can be done utilizing the LA GARD Reset Box (PN 704065) When reset using the 700 Series Reset Box, a lock
can be reset to these Default Settings:
« Super Master Reset Code will return to default 55555555 and must be set prior to changing the Manager code.
« Manager Code will return to default 123456
« No Active User will Exist
Once the Reset Box is connected to a safe lock, deleted users cannot be recovered. All settings will be restored to the default
values. While the Reset Box is connected to the lock, ALL communication from the Keypad is rejected. Access to the secured

area MUST be maintained (keep the access door open) until the Reset Box is disconnected from the lock. If the access door is
closed, the lock will have to be drilled to re-open.

To perform areset using the Reset Box:

1. Remove Batteries or Disconnect the lock from any power source.

2. Press and hold the O key for 10 seconds to discharge any residual energy.

3. Connect the Reset Box to the Safe Lock BAT port.

4. The Reset Box LED will illuminate for approximately 3 seconds and then stop when the reset is complete. Do not unplug the
box before the reset is complete.

5. Disconnect the Reset Box from the Safe Lock.

6. Once Successfully reset, the Manager Combination will be reset to the default 123456 and the Super Master Reset Code will
return to default 55555555.

7. Reconnect power to the lock. Test by opening the lock with the default Manager Combination of 123456.

Note: If the Reset Box LED does not turn on. Disconnect the Reset Box and repeat steps 1and 2.

Firmware Upgrade

When a new firmware is available, these files will be available to LA GARD Software users. Using the LA GARD Software client,
keypad and lock firmware can be updated. To update the Lock and Keypad Firmware to the current version, the Manager user
will require a PC with 700 Series Software, a 700 Series USB Dongle (PN 7047040), and a USB to Mini USB Cable (PN 203325).

1. Connect the Keypad to the PC. Plug the 700 Series USB Dongle into the USB Port of the PC. Plug the USB port of the cable
into the dongle. Then plug the mini-USB into the port on the lock Keypad.

2. Enter the Manager Combination and hold the last digit for 3 seconds (% LED remains on.

3.Press 6. (- LED remains on. Note: The unit is in Firmware Load Mode for about 60 seconds. During this period, the unit will
ignore any inputs from the keypad to allow communication between the software and the unit.

4. Use the software to select and upload the latest 700 BASIC firmware file. LED remains on until connection is established. If
no connection is established within 60 seconds, it will time out and the LED will turn off. Once the connection is established,
the keypad LED will blink green throughout the entire update process.

5. The Keypad LED will stop flashing green to signal that the firmware update is complete.

Note: 700 Basic Locks and Keypads are only compatible with 700 Basic Firmware. 700 Basic Firmware is not compatible with other
700 series models. If an incompatible firmware is chosen, the 700 Series Software will display an error and maintain the connection
until the compatible firmware is selected. To clear the error, select the appropriate firmware and complete the update.

If an incompatible command is selected, the lock may respond with a Red LED that may remain on for up to 20 seconds.
During that time the keypad will not respond to key presses.
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700 Series
Models: 701-7/05 Specs

Q

@

Model 701 Model 702/702D Model 703/703B Model 704/704B Model 705
2-User lock Multi-user lock Multi-user, 2-lock Multi-user, 5-lock Multi-user, 5-lock
standard keypad system, display system, display system, display
OLED Display Keypad No No/Yes (702D) Yes Yes Yes

Compatible Lock Types

Swing/Dead/Spring
Bolt/Redudant Lock

Swing/Dead/Spring
Bolt/Redudant Lock

Swing/Dead/Spring
Bolt/Redudant Lock

Swing/Dead/Spring
Bolt/Redudant Lock

Swing/Dead/Spring
Bolt/Redudant Lock

# of Users 1 Master/ 1 Master/ 1 Master/ 1 Master/ 1 Master/
1Manager/ 1Manager/ 1Manager/ 2 Managers/ 2 Managers/
1 User 28 Users 28 Users 47 Users 97 Users
# of Locks 1 1 2 5 5
Dual-User Mode No Yes Yes Yes Yes
g:::—r:i‘seer Mode No Yes Yes Yes Yes
Reset Function Yes Yes Yes Yes Yes
Time Delay No 0-99 min 0-99 min 0-99 min 0-99 min
Confirmation Window No 1-60 min 1-60 min 1-60 min 1-60 min
'(I'-:_nl:‘;eog)elay Override No Yes Yes Yes Yes
;E)?F‘g':h BLE No No No No Yes
::c;(g;;;r:able Yes Yes Yes Yes Yes
Programmable by PC No Yes Yes Yes Yes
Audit Events No 500 500 2000 6000
Viewable Audit Trail No No/Yes (702D) Yes Yes Yes
23;\:2 I'I'ort::?lu ble No Yes Yes Yes Yes
Duress Alarm No Yes Yes Yes Yes
Combination Length 11 (2id + 6-9) 11 (2id + 6-9) 11 (2id + 6-9) 11 (2id + 6-9) 11 (2id + 6-9)
Back Lit Keypad No Yes Yes Yes Yes
Bolt Switch Option** No Yes Yes Yes Yes
Wrong Try Penalty Yes Yes Yes Yes Yes
Battery Power 2x9V 2x9V 2x9V 2x9V 2 x9V
Low-Profile Option No Yes Yes Yes No
AC Power Option* Yes Yes Yes Yes Yes
VdS 2396 — Class 2 Yes Yes Yes Yes No
UL 2058 —UL Type 1 Yes Yes Yes Yes Yes
EN1300—Level B Yes Yes Yes Yes No
SBSC—-3880:2015 Yes Yes Yes Yes No
CNPP a2p—Level B/E Yes Yes Yes Yes No
Time Lock Schedule No No No Yes Yes
Dual Credential No No No/Yes (703B) No/Yes (704B) Yes

Warranty

2yr from DoM

2yr from DoM

2yr from DoM

2yr from DoM

2yr from DoM

Updatable Firmware

Yes

Yes

Yes

Yes

Yes

** Reference FAQ #33
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Frequently Asked Questions

Models 701-705 20
O G

dormakabq g

**Note The 701-705 are not compatible with 700 Basic Keypad and Locks.

1. Can all keypads and locks be interchangeable/paired together?

A. Yes, all locks and keypads work together in an out of box state. If locks are already paired to one system, they can
be reset, utilizing the LA GARD 700 Series Reset Box (704065) or the lock can be Uninstall (#23) from the old
keypad and installed to the new keypad. Note you do not need to reset or Uninstall (#23) a lock to the keypad if you
are switching the same model keypads.

2. Do dll keypads come with a display?
A. Keypad models 702D-705 come with a display

3. What type of locks do you offer?

A. Spring Bolt, Swing Bolt, Dead Bolt, Redundant
B. Locks can also include a bolt switch

4. Which keypads are compatible with the spindle locks?

A. All keypads can be used for both the dead bolt, spring bolt and swing bolt the spindles will come with the lock
instead of with the keypads

5. What keypads come in low profile? What else is needed for a low-profile keypad to function?

A.702,703,704

B. Each low-profile keypad will require a battery box (704055) or power supply/alarm-battery box (704045)

C. A battery connector is available in the standard battery area for emergency power needs should the battery box
batteries die

6. Where should the keypad cable be plugged in on the lock body?
A. ENT (Entry) Port

7. Can you mute the audible keystrokes?

A. Yes
Non-Display Model:
1. Using the Keypad, input #41 + Authorized User ID and Combination + Off (0O) or On (1) + Return Key°
2. The Keypad will beep three times and flash a green LED once complete.

Display Model:

1. Navigate through the Main Menu and select System

2. Select Buzzer from the sub-menu

3. Select Between Yes and No to Enable/Disable Buzzer Mode

4, Success Mode updated will appear on screen and the Keypad will beep twice and flash a green LED once



10.

1.

12.

13.

14.

15.

16.

17.

How can | tell which model keypad | have?

A.

Each keypad will have a label:

« Standard profile - the label is in the battery compartment on the right side wall

« Low profile — the label is located on the inside of the swing door on the lower fascia plate
leading to the connector access

. On the display model through the OLED Menu prompts you can check under System = Sys Info = Entry and scroll

down to see model number

. To identify the difference between the 701 and 702 non-display kepads use the backlight command. Use the

Keypad, input #40 + Authorized User ID and Combination + Off (0) or On (1) + Return Key° If the keys light up, it
is a 702. If the keypad gives you red beeps after pressing #40, it is a 701.

What is the difference between #23 and #25 command (701, 702)?

A.

Uninstall (#23) "unpairs” that keypad from that lock, but the lock retains all the settings and combos. You would
only UNINSTALL if you were intentionally swapping out your keypad. The Uninstall command needs only to be used
when swapping keypads with a different model (e.g. changing a 702 to a 703). When exchanging keypads for the
same model (a "hot swap") simply use the Reinstall (#32) command. For display units, the system recognizes the
"hot swap" and guides the user through the Reinstall process.

(#25) is the Master Reset, which returns the lock to factory settings. No programming data is retained. Audit data
does remain in the lock. You would do this if you were changing the model of the replacement keypad or if you
simply wanted to decommission the lock and get it back to factory settings.

On 701, does the manager have to be ‘01" and the access user be '02'?

A.

You can use ether 'O1" or '02' for the 701 manager or user. Note the 701 only has user 01 and 02 available

What is the Primary Lock?

A.

When using multiple locks, the Primary Lock is lock number one (#1) in a multi-lock configuration

Why does the keypad need to know which lock is the Primary Lock?

A.

The keypad will need to know which lock has an Alarm Box attached to it

Do you offer a warranty?

A.

2 years from date of manufacture

What color options do you offer?
A. Black and Satin Chrome

What type of batteries does the keypad take?
A. The battery box and tray fit 2-9V Alkaline Batteries

B.

The system can operate with 1-9V Battery, although not recommended

How many openings can be performed on 2 9V batteries?

A. We estimate that 2 new 9V premium batteries (e.g. Duracell or Energizer) can last up to two years under optimal

B.

conditions.

The LA GARD 700 Series provides a low battery indicator for low battery condition and critically low battery
condition. Battery life can vary because of environmental conditions, frequency of use and battery quality. We
recommend that you establish a routine battery maintenance plan.

Is there a low battery warning?

A. Yes, the lock will alert if the battery is low

Event Buzzer LED Screen Messages Display Only
Low Battery 1 Long Low Beep 1Long Flash Low Battery
Critical Low Battery 3 Long Low Beeps 3 Long Flashes Critical Low Battery

13



18.

19.

20.

21.

22,

23.

14

How do | wake the lock?

A. Press any button on the non-display and display models

What certifications does the 700 Series have?

. UL —Yes

Vds — Yes (except 705)

. CNPP — Yes (except 705)
UKCAE — Yes (except 705)
EN1300 — Yes (except 705)
A2P — Yes (except 705)

. ECB-S — Yes (except 705)

. CE — Yes (except 705)

IOQMMUOD»

Is the 700 Series backwards compatible to various iterations of Legacy LA GARD?
A. The 700 Series is not backwards compatible with legacy LA GARD

Do the current accessories work with the new 700 Series?

A. AC Power Supply — (701107) Yes
There is a new group of accessories for the 700 Series

Item Part Number
Battery Box 704055
FOB B20165
Multiplexer 704033
Reset Box 704065
Alarm Box 704045
18-inch Multiplexer to Lock Cable 431091
36-inch Multiplexer to Lock Cable 43109-2
72-inch Multiplexer to Lock Cable 702130
120-inch Multiplexer to Lock Cable 702131
USB Dongle 707040
USB to micro-USB Cable 203325
AC-Power Supply multi-adapter 701107

Can the BLE FOB be paired to multiple locks and multiple users?

A. While we recommend it be a 1:1 for users, the FOB may be used for both multiple locks and multiple users, if the
user elects to configure access in this manner.

What do the flashes on the BLE fob indicate?

A. Green LED will flash on a button press

B. If successful connection, ID exchanged with entry, there will be a second green LED flash
« ~1 second apart

C. If connection or ID exchanged with entry failed, there will be a red LED flash
« ~5 seconds apart

D. Button presses are ignored during connection attempt and ID exchange

BLE FOB — Battery Status:

A. When the battery voltage is between 2.3 and 2.1 volts, the first green LED flash will be replaced by a yellow/orange
flash (both green and red LEDs on) indicating a low battery condition.
When the battery voltage is below 2.1 volts, there will be a red LED flash on button press indicating dead battery
condition. In this state, no attempt will be made to connect to the entry.



24,

25.

26.

27.

28.

29.

30.

On button press

ID exchange status

Translation

Green

Green (~1second after 1st LED)

Successful identify

Green

Red (-5 second after 1st LED)

Failed identify

Yellow/Orange

Green (~1second after 1st LED)

Successful identify — low battery state

Yellow/Orange

Red (-5 second after 1st LED)

Failed identify — low battery state

Red LED

None

Can the battery in the BLE fob be replaced?
A. Yes, the BLE fob can be opened to replace the battery

What type of battery does the BLE fob take?

A. CR2032

Can | program my lock with the LA GARD software?
A. Yes, the 702-705 can be used with the software for set up

Dead battery state

B. The time schedules for the 704 & 705 must be programmed using the software

How do | retrieve my firmware updates?

A. Firmware can be downloaded at no additional cost through the free version of our software application with the
USB Cable (203325) and USB Dongle (707040)

The LA GARD Software password is not working, is there any way to reset it?
A. No but the default is LAGARD

Does the software need to be license on each computer?

A. Yes

How many locks per license?

Part Number

Maximum Locks Managed

Comment

700068 100 Maximum Per Database
700069 250 Maximum Per Database
700074 1000 Maximum Per Database

31. Why is my lock is not connecting to the software?

32. Why is my USB dongle not showing up in device manager?

A. Make sure you have a USB dongle to connect to the software

A. Need to install the USB drivers:
Go to https://ftdichip.com/drivers/d2xx-drivers to download the drivers

33. What does the bolt switch do?

There are 3 options on the lock bodies:

A. No Bolt Switch (reference no bolt switch in price book)

B. Internal Bolt Switch - this allows for visibility on the audit log for open and close status of the bolt (reference

second option for lock ordering where it indicates with bolt switch)

C. External Bolt Switch - this will be a harness that allows for external 3rd party wiring into an alarm system for
normally open/normally closed status. This does not provide an audit when this feature is used. (reference under
configurable options: bolt switch with wiring harness)

34. How do | get a copy of the latest 700 Series software or firmware?

A. The new software and firmware versions are requested from the website just like when the software was first
acquired: https://www.dormakaba.com/us-en/knowledge-center/la-gard-software-download/la-gard-700-
series-software-download
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35. How do | upgrade my software?

36.

37.
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A.

Install the new software as an administrator. The existing version does not need to be removed first.
All your data is retained.

How do | upgrade the firmware in my lock and keypad?

A.
B.

From the LA GARD Software Main Menu, select Settings

Fill out the following information in the Firmware Update sub-menu:

« Port — From the drop-down menu, select the applicable comms port

« Firmware File — Use the Select File button to navigate through the computer to find the firmware update file.
Select Open in the browser window when the file is located

« If lock firmware is selected, another option will be presented to select which lock to update
(NOTE: only one lock firmware can be updated at a time)

. Plug the USB cable into the USB port of the computer and the other end into the mini-USB port of the Keypad
. If using a Keypad with a display, do the following:

« Using the Arrow buttons on the Keypad, navigate through the Main Menu and select System by pressing the
Return Key

« In the System menu, navigate through the options and select FW Update by pressing the Return KeyQ Start
FW Update will appear on the display screen

. If using a Keypad without a display, do the following:

« Press #99 + Master Combo

This will set the Keypad into the FW Update Mode
In the software client, select the Upload button. A progress bar will appear on screen. The Keypad will beep three
times and flash a green LED once complete

Note all users and combos wiill still be programed in the lock and no data will be lost when
updating the firmware

| tried to upgrade my lock/keypad's firmware and the keypad is unresponsive while displaying Lock 1 boot
and F/W update. What is this and how can I fix it?

A.

This happens when the firmware update is interrupted, and the keypad is stuck in the firmware update mode. This
can be fixed by doing the following:
« If the lock is not attached to a multiplexer:
Connect the keypad to the PC and resend the firmware from the software
« If the lock is attached to a multiplexer:
Disconnect the lock and keypad from the multiplexer and connect the lock to the keypad.
Connect the keypad to the PC and resend the firmware from the software.



Appendix A

LA GARD Display Models
High Security Lock for Safes & Vaults
Standard User Instructions

Available users and default codes

Locks are frequently set up so that ID O1is assigned a
Manager Profile with default privilege to Open and Audit
the lock. It is common practice to assign a default
combination to that user of 123456.

ID Profile (ID) Default Code

00 Master (0-0)-1-2-3-4-5-6-7-8

01 Manager (0-1)-Can be added by the Master User

02-29 Users Can be added by the Master or Manager

Warning: The Master user must change their combination
upon first use. The Master User can require Manager and
Standard users to change their combinations on first use by
turning on the Force Change Combo rule in system settings.

User hierarchy

Master (O 0)

Y
Manager (0 1)

Y
Users (02-29)

A

User Profiles

Profile Permission

« Administrative control of lock and other users.
« Cannot open directly

Master

« Open lock, Change own code

« Manage users (Add, delete, disable, enable,
reset)

« Manage time delay values

« Activate PC link for audit

» Set date and time

« Turn backlit buttons and keypad beeps off or on

« Override time delay (If profiled)

Manager

User » Open lock, Change own code
« Override time delay (If profiled)

« Activate PC link for audit (If profiled)

Code length

The Master code always contains ID OO0 + 8-digits. Other
user codes contain the 2-digit ID + 6-digits by default but
can be changed so that 6-9 digits are used.

Key Use

@®®  Arrow Up or Arrow Down: To scroll through menus
® #: To go back a step in a menu, or cancel a code entry
() Enter: To select a menu item or confirm an entry

Commands

Non-opening functions are available to Users depending on
their profile. These instructions cover the coommands listed
below:

Category Function

Codes Change code

User Add a User

management  Disable or re-enable a User
Change User privilege
Delete a User
Reset a User code

Time delay Amend time delay values
Cancel time delay counting

General Disable or enable backlit buttons

operation Turn keypad beeps off or on

Set time and date

Advanced commands are available in a separate document:
Advanced User Instructions available to download from our
website.

17



Category Function

Codes Change code length
" Enable or disable dual mode
g General Enable or disable the Duress feature
£ operation Specify alarm input setting
§ Audit Activate PC link, view audit event codes
° Manager Add a Manager
(Y] .
< management Disable or re-enable a Manager
3 Change Manager privilege
< Delete a Manager

Reset a Manager code
Time delay Enable time delay override feature

Adjust time delay count mode

Command menu

To access the command menu:
+ Press either Arrow Up, Arrow Down or Enter

00

« Enter a valid ID and when prompted, the code

Command menu navigation

Use the Arrow Up and Arrow Down keys to scroll through
menus. When a menu item or option is selected, it is
highlighted in white. Press Enter to either confirm the
selection or access a sub-menu. Press # to return to the
previous menu or to exit.

Visual and acoustic signals

Lock status is indicated with display messages and LED
flashes and beeps.

Signal Symbol

Green flash + short high beep

Meaning: Button pressed correctly

LD

Red flash + short low beep or:
Meaning: Invalid key

3 green flashes + short high beeps

Meaning: Command or code accepted

BI6) _ o) ) ()

3 red flashes + short low beeps ISP

Meaning: Invalid code or command

Open the lock Manager/Users

Depending on the construction of the safe or vault, other
locks such as key locks may need to be opened first. Any
actions required to open the door and lock should be
reversed to close and secure the door and lock.

« Enter a valid ID, and when prompted, the code
« Within 3 seconds, turn the keypad and/or turn safe handle

Open the lock when time delay is active

Follow these steps to open a safe lock during a Time Delay
on a Display Keypad:

1. Using the Keypad, input the User ID and Combination.

2. For multi-lock systems, select the corresponding lock number
on the keypad. Otherwise, skip to the next step.

3. "Lock # Start Delay" will appear on screen and provide timer
feedback. The type of feedback depends on the setting for
count feedback (the time may count down, up, or only show
time remaining). A key must be pressed to check the Time
Delay status. When a key is pressed on a Display Keypad, the
‘most urgent’ lock will be displayed. a) Most Urgent Lock: In a
single lock system, the Time Delay status is for a single lock,
in a multi-lock system, the status will be provided for i) the
lock with the least amount of time remaining in the
confirmation window, or ii) if no lock is in the confirmation
window, then the lock with the least amount of time
remaining will be present in the delay window

4. Once the Time Delay period expires, "Lock # status Confirm"
appears on screen.

5.If alock is in the confirmation window, it can be opened.
Press a key to exit the Time Delay Status.

6. Input the User ID and Combination.

7. From the sub-menu, select "Open Lock". a) For multi-lock
systems, select the corresponding lock number on the
keypad. If the selected lock has Time Delay enabled and i) is
not already in Time Delay, Time Delay will start for the lock,
and ii) is already in Time Delay and the confirmation window,
then the lock will open

8. The lock will open, and the screen will display “Lock Open”.
After a few seconds, the lock will close.

Override time delay

If the feature has been enabled, see Advanced User
Instructions, and a User has been profiled with the privilege
to override time delay, their code is valid to open the lock
immediately.

Open the lock if operating in dual mode

« Enter a valid ID, and when prompted, the code
« Enter a 2nd valid ID, and when prompted, the code
« Within 3 seconds, turn the keypad and/or turn safe handle

Dual mode for the Manager Manager

If the lock has been set to operate dual mode for Users +
Manager, to access command menus, press either Arrow
Up, Arrow Down or Enter to view a menu. Select Go to
Menu. The Manager must enter their ID and code first,
followed by a second valid ID and code.



Backlit buttons Master/Manager

Keypad buttons can be illuminated on first button press to
provide a guide in dark areas. By default, backlit buttons are
turned off.

Command Menu > System > Backlight > Select on or off

Keypad beeps Master/Manager

Keypad beeps can be turned off to prevent others hearing
that the lock is being operated.

Command Menu > System > Buzzer > Select on or off

Add a User Master/Manager

« Enter a valid User Id and Combination
Command Menu>Users> Add

+ Enter the new User ID

« Select the User Type Manger or Standard User

+ Input Combination then enter the Combination again
when prompted to “Confirm"

+ Select Add User

Default Privileges for both Manager and Standard Users are
Access and Audit. To customize Privileges for the user select
from the available options; “Open Priv" (Open Privilege),
"Audit Priv" (Audit Privilege), or "TDO Pin Priv" (TDO with Pin
Privilege). If adding a Manager, the "TimeLock" Privilege will
also be available.

Change code All

Opening codes should be changed and tested with the safe
or vault door open where possible.

Manager and Standard Users should change their

combination and perform a test opening upon first use. This
is not required with the default system settings. The Master
User can turn on the Force Combination Change Rule which
will force the users to change their combination upon first use.

Command Menu > Change combo > Enter the new code twice
1. Enter an Authorized User ID and Combination.
2. From the Keypad display Main Menu, select "Change combo”

3. "New Combo" appears on screen. Input a new combination
with the number pad.

Note: The new Combination must be different from the old
Combination. The User is advised to use a non-trivial
combination.

4. "Confirm" appears on screen. Input the same combination
from the previous step to confirm.

5. "Success" will appear on screen. The Keypad will beep three
times with a green LED and return to the Enter ID menu
once complete. The new combination is set and will be in
effect the next time the User enters their combination.

Change code when dual mode is active All

» When dual mode is active, press either Arrow Up, Arrow
Down or Enter to access the command menu, then scroll
to Change combo

» Enter a valid ID, and when prompted, enter existing code

« Enter the new code, then repeat the new code to confirm

Disable or re-enable a User Master/Manager

A user code can be temporarily disabled and then
re-enabled later.

Command Menu > Users > Edit > Enter the ID to be changed

» Select Status > Select disabled or enabled

Change User privilege Master/Manager

It is possible to redefine a user's privilege to allow or
disallow opening, audit or time delay override for each lock
that may be connected to the keypad.

Command Menu > Users > Edit > Enter the ID to be changed
« Select Privileges

A sub-menu is displayed > Privileges >
> Open Priv
> Audit Priv
> TDO Pin Priv
> Update User

« Select Open Priv, Audit Privand TDO Pin Privand amend
as required using the instruction in Add a User.

« Select Update User

Delete a User Master/Manager

Command Menu > Users > Delete > Enter the ID to be deleted

« When the display shows Confirm delete: xx, press Enter

Reset a User code Master/Manager

If a User has forgotten their code, it is possible to reset it
rather than deleting and adding the User again.

Command Menu > Users > Edit > Reset combo > Enter an
authorized |d and Combination

« Enter the new code, then repeat the new code to confirm

After the code has been reset successfully, the User should
change their combination and perform a test opening with
the door open. If the system has been programmed for the
Force Combination Change to be turned on, the user must
change their combination before first use.



Set date and time Master/Manager

To maintain the integrity of the audit, it is important to
ensure that date and time is set on an annual basis and
re-established after a power loss lasting for more than a
few minutes.

Command Menu > Enter a Valid User ID and Combination
> Time/Date > Set Time Date

The display will show the current lock time and date

+ Press Enter
« Enter new values in the format shown onscreen, noting
that the date starts with YY for Year

Amend time delay values Master/Manager

Time delay is a feature that requires a period of time to
elapse before the lock can be opened, to prevent Users from
being coerced into opening the safe or vault immediately.

Command Menu > Enter a valid User Id and Combination
> System > Locks > Time delay >
Configure Times

« Select Delay period

« Enter 2 digits to indicate the time delay (00-99 minutes)

« Select Confirm window

« Enter 2 digits to indicate the open window (01-60 minutes)

If time delay values need to be reduced or removed, the
procedure can be carried out at any time, but one complete
cycle (Time delay, open lock) of the previous settings must
occur before the new settings take effect. To remove time
delay, use OO0 for the delay and O1 for the open
(confirmation) window.

Cancel time delay counting All

If time delay has been initiated but is no longer required, it
can be cancelled.

+ Press any key to wake the display

« Press any key to access the code entry screen
« Enter avalid ID and when prompted, the code
+ Select Cancel TD
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Troubleshooting

If a mistake is made during code or command entry
Press # to cancel

There is no response from the lock
The batteries may be depleted. Change the batteries then
set the date and time to ensure accuracy of the audit data.

The safe or vault door does not open
If the lock system is otherwise operating normally, there may
be a mechanical fault with the safe. Contact a safe engineer.

Menu structure

Master Manager User
Open Lock v v
Change combo v v
Time / Date... v
> Time Format
> Date Format
> Set Time Date
> Observe DST
Audits...
PC Link
Users...
> Add...
> Open Priv
> Audit Priv
> TDO Pin Priv
> Add user
> Edit...
> Status
> Reset Combo
> Privileges

Vs privileged

v Hif privileged

AN N N N N N N N U U N NN

> User Type
> Delete...
System...

> Sys Info...
> Entry
> Lock

> Backlight

> Buzzer

> TD cnt Mode...
> Delay Period

CAOLCKCKKAK
AN

> Confirm Window
> Combinations
> Combo Length
> Force Combo Change
> User mode
> Duress mode
> Input Signal
> Locks...

<

> Uninstall
> Time Delay...
> Configure Times...
> Delay Period
> Confirm Window

AR NN

> Change Override
> Reset
> FW Update

<

Document version

These instructions may be updated from time to time, please
refer back to website for any updates.



Appendix B

Simple Set-Up: 701 with 1 Manager/1 Standard User/6 Digit Combination
Navigation Tips

« Any key press wakes the system. The commands below are shown with the ° as the key press
for waking the system. When not needed, the lock will respond with a short red flash ( .) and low
beep « signaling that the lock is ignoring RETURN and waiting for your # command.

+ # key during a command sequence will cancel the sequence

« Start a new open command string by entering id and combination

. ° Return Key generally submits the prior keystrokes

+ Successful # command will receive a response with (. ( .)(. o) ) )

+ Failed # command will receive a response with ( ./ (.

« The light indicator will remain green during entry of a # command. This light will turn off when the
command is canceled or completed.

Initial Set Up Commands (for 1 Manager/1 Standard User)

The commands below are shown with the ° as the key press for waking the system. When not needed the lock will respond with a short red
flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Action Command String Result
Open the container using the Factory Default Open Code of 1. Keep the container open while performing these set up commands.
Step 1 Add Preconfigured (- E X - IBIBIGI DL DL D IBIGIGP) Keypad: (")) () ) o) 2)
::rset:;:'\‘f"'\i”t:red Manager: #50 Lock: Installed with Manager User O1 Enabled,
User 9 Change Master @ #52 00 (ID) 12345678 (Combo) Combination = 123456, Privileges: Users should
Combination: #52 oo0(UD) ________ (New 8 Digit Combo) | change the combination for first use
oo(lD) ________ (New Combo) @
Install Lock: #22 @ [22] +[00] + [8 Digit Combo] @
BIGIGIPLPLD)
Step 2 Add Standard User with Standard User Keypad: () (0) () ) ) )
Open Only: #50 @ #5000 ________ 02 123456 2 1 @
Open Only Privilege Lock: New User with Open Privileges, Users
should change the combination for first use
Step 3 Change Manager @ #52 01(ID) 123456 (Combo) Keypad: () () ) o) 4)
Change Combination: #52 o1uD) __ (New 6 Digit Combo) o
Combinations oDy (New Combo) @ Lock: Combination Changed
(Recommended)
Change Standard User @ #52 02(ID) 123456 (Combo) Keypad: () (") () ) ) 0)
Combination: #52 02(D) ______ (New 6 Digit Combo) o
020Dy ______ (New Combo) o Lock: Combination Changed
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Other System Function Settings

The commands below are shown with the o as the key press for waking the system. When not needed the lock will respond with a short red
flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Action Command String Requirement Result
Set/Change @ #moowWp) ________ (Combo) 6 @ for 6 digit Master Only Keypad: () ) ) ) ) 0)
Combination . .
Length: #11 ©#Moowd) ________ (Combo) 7 @ for 7 digit L\lote: I't'T’pGCt Lock: Combo length changed for Manager
. o existing user
@® #1100(D) ________ (Combo) 8 @ for8digit | cormbinations :”d St;”dc’rdgsers o i
.. ote: Master Combo length does not change
@ #1100(UD) ________ (Combo) 9 @ for 9 digit from 8 characters. Changing the Combo
Length will impact existing user combos.
*Use the Master to Reset User combos after
changing the Combo Length. Users should
then change combo for first use.
Set Force Force Combination Change On/Off: Master Only Keypad: () () () a) ) €)
Change Combo | #17 (Default Off)
Lock: Require Combination Chagne on First
Use will be On/Off
Do Not Require Combo Change:
@ #1700UD) ________ (o) -}
Require Combo Change:
@#17000D) ________ 1®
Set Buzzer to © #4 __(D) ________ (Combo) O © for Buzzer Off | Master or Keypad: (. ) ) ) 1)
On/Off:#41 | @y __aoy ________ (Combo) 1@ for Buzzeron | Manager Lock: Buzzer is On/Off
Enable FW @49 _ D) ________ (Combo) @ Master or Keypad: 7)) (7 ) 4) €)
Update Port: Manager
#90 Lock: Firmware can be updated by
700 Series Software
Open PC Link: ® #30 __ (D) ________ (Combo) (] Master, Keypad: () () (%) ) ) )
#30 Manager or Green LED blinks during data transfer
User with
Privilege Lock: Can be configured by software

Note: 701 models only support PC LINK
Compare. No programing or audit features
exist. 701 does not support programming or
audit features.

Operation Commands

The commands below are shown with the ° as the key press for waking the system. When not needed the lock will respond with a short red
flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Action Command String Requirement Result
Chanqe ) ® #52 __(D) ______ (Combo) Master, Mcr.woggr or Standard Keypad: ( () ) ) )
Combination: Dy (New Combo) User, Cqmblnotlon Iength 6-9 Lock: Combination Changed
#52 oy __ (New Combo) @ as required (Master requires 8)
Open Lock ®________ (Combo) Manager or Standard Keypad: ) (0)(0) 49 49 4)
(Single User) User with Privilege

o g Lock: Opens
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User Administration Commands

The commands below are shown with the o as the key press for waking the system. When not needed the lock will respond with a short red
flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Action Command String Requirement Result
Add Standard ® #50 __(D) ______ (Combo) Master or Manager D o) ) )
User: #30 ——(NewlD) ______ (New Combo) 21 Combination Length Lock: New User with Privileges as
(Standard User/Open Privilege) @ must meet requirement | iqentified, User should change combination
for first use
Add Manager ° #50 0O(ID) ______ (Combo) Master Only Keypad: — — — ) ) 0)
User: #50 —— (New D) == .(New Combo) 41 Manager must be Lock: New User with Privileges as identified,
(Manager/Open Privilege) @ created by Master. User should change combination for first use
Combination Length
must meet requirement
User Enable/ | @ #54 (D) ______ (Combo) __ (User to Master or Manager Keypad: ) () () ) ) )
Disable: #54 Change) O Q to Disable User Manager must be Lock: User Enabled/Disabled
@ #54 __(D) ______ (Combo) __ (Userto mndnagedbyiiviasten
Change) 1 @ to Enable User
Edit User Open Only: @ #55 __(ID) ______ (Combo) Master or Manager Keypad: ") ) ) ) )
ZrSI\SIIIeges. ——(User to Change) 1 @ Manager privileges must | | gck: User Privilege changed as identified
be edited by Master
Delete User: ° #56 __ (D) ______ (Combo) __ (User Master or Manager Keypad: ” L) ) )
#5 i [Pl Manager must be Lock: User Deleted
deleted by Master
Reset ‘Use.r ®#57__(D) ______ (Combo) Master or Manager Keypad: () () ) ) 0)
gg;“blnqtlon- --(IDtoReset) ______ (New Combo) Manager must be reset | | oele: User will have new Initial Combination.
——(IDtoReset) ______ (New Combo) @ by Master User should change combination for first use.
Combination Length
must meet requirement

Uninstall/Reinstall/Reset Keypad and Lock

The commands below are shown with the ° as the key press for waking the system. When not needed the lock will respond with a short red
flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Audit Events shown below are not recorded for 701 Models.

Action Command String Requirement Result
Reinstall ©® #32__(D) ______ (Combo) @ Open Privilege Required | Keypad: Alternating Red and Green
Keypad: #32 Flashes indicate the same Keypad Model
is not paired, Success indicated with
(OO ) ) 1)
Lock: Lock is Installed to Keypad
t’ni?(sﬁzn.e © #23000D) ________ (Combo) @ Master Only Keypad: ") () () ) 4)
ock:
Lock: Is no longer installed to Keypad, all
settings are maintained
z;;et Lock: | @ #25 00(D) ________ (Combo) @ Master Only Keypad: ) () ) ) 4) ¢)
Lock: Master Combo is reset to 12345678, All
users deleted, All Factory Defaults restored,
Lock will be uninstalled from Keypad
Install Lock: ° #22 00(D) ________ (Combo) ° Uninstalled: Master Keypad: () () o) 1) )
#22 Combination has been
changed from default. | Lock: Installed
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Appendix C

Simple Set-Up: 702 with 1 Manager/1 Standard User/6 Digit Combination

Navigation Tips

« Any key press wakes the system. The commands below are shown with the ° as the key press
for waking the system. When not needed, the lock will respond with a short red flash ( .) and low
beep « signaling that the lock is ignoring RETURN and waiting for your # command.

+ # key during a command sequence will cancel the sequence

« Start a new open command string by entering id and combination

. ° Return Key generally submits the prior keystrokes
+ Successful # command will receive a response with (. ( .)(. o) ) )

+ Failed # command will receive a response with (.

G)( OO

« The light indicator will remain green during entry of a # command. This light will turn off when the

command is canceled or completed.

Initial Set Up Commands (for 1 Manager/1 Standard User)

The commands below are shown with the ° as the key press for waking the system. When not needed the lock will respond with a short red
flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Audit Events shown below are not recorded for 701 Models.

Action

Command String

Result

Open the container using the Factory Default Open Code of 1. Keep the container open while performing these set up commands.

Step 1 Add Preconfigured O #0000 ) WO e Keypad: (")) (") ) ) #)
g‘rset:clln‘i”\i”t:red Manager: #50 Lock: Installed with Manager User O1 Enabled,
User 9 Change Master @ #52 00 (ID) 12345678 (Combo) Combination = 123456, Privileges: Users should
Combination: #52 ooy ________ (New 8 Digit Combo) | change the combination for first use
0Dy - (New Combo) @ Audit: Event 5 & 14 Recorded
Install Lock: #22 @ [22] +[00] + [8 Digit Combo] @
OO0 ) )
Step 2 Add Standard User with Standard User D) ) )
Open Only: #50 @ #5000 ________ 02 123456 21 @
Open Only Privilege Lock: New User with Open Privileges, Users
should change the combination for first use
Audit: Event 14 Recorded
Step 3 Change Manager @ #52 01(ID) 123456 (Combo) Keypad: () (") () ) ) 0)
Change Combination: #52 o1(D) ______ (New 6 Digit Combo) o
Combinations oDy ______ (New Combo) @ Lock: Combination Changed
(Recommended) Audit: Event 14 Recorded
Change Standard User @ #52 02(ID) 123456 (Combo) Keypad: (")) () a») ) )
Combination: #52 02(D) ______ (New 6 Digit Combo) o
02(D) ______ (New Combo) ° Lock: Combination Changed
Audit: Event 14 Recorded
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Other System Function Settings

The commands below are shown with the o as the key press for waking the system. When not needed the lock will respond with a short red

flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Audit Events shown below are not recorded for 701 Models.

Action Command String Requirement Result
Set/Change @ #mMoodb) ________ (Combo) 6 @ for 6 digit Master Only Keypad: () (0) ) ) 4) €)
Combination o
Length: #11 ©@#moow ________ (Combo) 7 @ for 7 digit :‘Otef I?poct Lock: Combo length changed for Manager
. o existing user
© #1100(D) ________ (Combo) 8 @ for8digit | copmations | °° 5t°”d°rdcusers~ . i
. Note: Master Combo length does not change
° i GOURY oo i) o e o ehars from 8 characters. Changing the Combo
Length will impact existing user combos.
*Use the Master to Reset User combos after
changing the Combo Length. Users should
then change combo for first use.
Audit: Event 31 Recorded
Set Force Force Combination Change On/Off: Master Only Keypad: () () (") ) ) )
Change Combo | #17 (Default Off)
Lock: Require Combination Chagne on First
Use will be On/Off
Do Not Require Combo Change: .
@ #17 00(D) ________ 0® Audit: Event 46 Recorded
Require Combo Change:
@#17000D) ________ 1®
Set Buzzer to ° #41 __ (D) ________ (Combo) O ° for Buzzer Off | Master or Keypad: (" (’f;.‘,)) ) )
On/Off: #41 ° #41 __UD) ____ (Combo) 1 O for Buzzer On e Lock: Buzzer is On/Off
Enable FW © 499 __(Dy ________ (Combo) @ Master or Keypad: (7)) ) ) )
Update Port: Manager
#99 Lock: Firmware can be updated by
700 Series Software
Audit: Event 37/38 Recorded
Open PC Link: ® #30 __UDy ________ (Combo) (] Master, Keypad: (0) () () ) 4) 0)
#30 Manager or Green LED blinks during data transfer
User with
Privilege Lock: Can be configured by software
Audit: Event 33 & 34 Recorded
Note: 702 Models support PC LINK Compare,
Programming and Audit Features not
available on 701
Sez B;g;l;ghto © 40 __Dy ________ (Combo) 0 @ for Off Master or Keypad: ") (7)) w) 4) €)
toOn T H4 Manager
(702 Only) © w0 __apy ________ (Combo) 1@ forOn (702 Only) Lock: Backlight is On/Off
Set Local Time: | #65 __(ID) ________ (Combo) YYMMDD HHmm © Master or Keypad: ) () () ) ) )
#65 (702 Only) YY=Year, MM=Month, DD=Day, HHmm=Hour/Minute (24 hours) MGnOger .
(702 Only) Lock: Time Set
Audit: Event 2 Recorded
Enuble// to Enable: #72 __(D) ________ (Combo) XX YY () Master or Keypad: (")) (") ) ) )
Disable/Modify - iod Mi _ - ; ; indow Mi _ Manager
Time De|qy: XX=Delay Period Minutes 1-99, YY=Confirmation Window Minutes 1-60 702 On|y) Lock: Time Deloy is Enabled with selected Deloy

#72 (702 Only)

to Disable: #72 __(ID) (Combo) 00 01 °
00=Delay Period Minutes, 01=Confirmation Window Minutes

Period and Confirmation Window or Disabled
Audit: Event 8 Recorded

Note: When modifying time delay settings to
disable or reduce Delay Period, the new time
delay setting will not be effective until the
lock is opened successfully under the previous
delay requirement
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Allow Time #73 00 (|D) ________ (Combo) 1 ° to Master Only KeYPOd; T T ‘:\/“’)) ‘))) ‘)))
Delay Override (702 Only)
(TDO): #73 Enable and Allow TDO Lock: Time Delay Override is Enabled/Disabled
(702 Only) #7300(D) ________ (Combo) 0 @ to Audit: Event 39/40 Recorded
Disable and Disallow TDO
Configure #16 00(D) ________ (Combo) O @ Ignore Master Only Keypad: () () (L ) ) 0)
Input Signal: (702 Only) ) . -
#16 (702 Only) | #16 00(D) ________ (Combo) 1 @ Remote Lockout Lock: Lock will react to Input Signal as indicated
#16 00(ID) ________ (Combo) 2 @ Remote TDO Audit: Event 43 Recorded
#16 O0O(UD) ________ (Combo) 3 Q Dual User Override
SetUser Mode: | 41 oo(Dy ________ (Combo) 0 @ Single User Master Only Keypad: () ) ) ) ) 4)
#12 (702 Only) (702 Only)
#12 00(D) ________ (Combo) 1 ° Dual User, does not Lock: User Mode is set as defined as selected
apply to manager Audit: Event 30 Recorded
#12 00(D) ________ (Combo) 2 ° Dual User, does
apply to manager
Enable/Disable | 414 oo (D) ________ (Combo) 0 @ to Disable Master Only Keypad: ) () () 4) )
Duress Mode: (702 Only) o
#14 (702 Only) | #14 00(D) ________ (Combo) 1 Q to Enable Lock: Duress Mode is Disabled/Enabled

Operation Commands

The commands below are shown with the ° as the key press for waking the system. When not needed the lock will respond with a short red
flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Audit Events shown below are not recorded for 701 Models.

Action

Change
Combination:
#52

Command String

@ #52 __(D) ______ (Combo)
__(Dy ______ (New Combo)
__(UD) ______ (New Combo) @

Requirement

Master, Manager or Standard
User, Combination length 6-9
as required (Master requires 8)

Result

(0 ) ) ) )

Lock: Combination Changed
Audit: Event 14 Recorded

Open Lock
(Single User)

(Combo)
Signal Duress +1/-1last digit of combination (702 Only)

Alarm box and Alarm Connectivity required for Silent Alarm

Manager or Standard
User with Privilege

Keypad: () () () ) 4) )

Lock: Opens

Audit:

Event 10 Recorded for successful Unlock
Event 21 when Unlocked with TDO

Event 23 when Unlocked with Duress Combo
Event 18 Bolt Retracted (Bolt Switch Required)
Event 19 Bolt Extended (Bolt Switch Required)

Open Lock
(Dual User)
(702 Only)

o __(D) (Combo)

® __(D) (Combo)
Signal Duress +1/-1last digit of combination (702 Only)

Alarm box and Alarm Connectivity required for Silent Alarm

Manager or Standard
User with Privilege

Keypad: () () C) ) ) )
Lock: Opens

Audit:

Event 10 Recorded for successful Unlock
Event 21 when Unlocked with TDO

Event 23 when Unlocked with Duress Combo
Event 18 Bolt Retracted (Bolt Switch Required)
Event 19 Bolt Extended (Bolt Switch Required)

Cancel Time
Delay: #74
(702 Only)

#74 __ (D) ______ (Combo) @

Master, Manager or
Standard User

Time Delay Period
must be active

Keypad: () (") () ) ) 0)

Lock: Remains Locked. Delay Period is
Ended. No Opening Window will be started.
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User Administration Commands

The commands below are shown with the ° as the key press for waking the system. When not needed the lock will respond with a short red
flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Audit Events shown below are not recorded for 701 Models.

Action Command String Requirement Result
Add Standard OpenOnly: @ #50 __(ID) ______ (Combo) Master or Manager Keypad: ( () ) ) )
User: #50 N
——(NewlD) ______ (New Combo) 21 @ Combination Le.ngth Lock: New User with Privileges as identified,
Audit Only: @ #50 __(ID) ______ (Combo) must meet requirement | ser should change combination for first use
__(NewlD) ______ (New Combo) 22 @ Audit: Event 14 Recorded
Open + Audit: @ #50 __(D) ______ (Combo)
__(NewlD) ______ (New Combo) 23 @
Open+TDO: @ #50 __(D) ______ (Combo)
__(NewlD) ______ (New Combo) 25 @
Open + Audit + TDO: @ #50 __(D) ______
(Combo) __(NewlID) ______ (New Combo) 27 @
Add Manager | open Only: @ #50 00 (ID) ________ (Combo) | Master Only Keypad: () () (. «0) €) 4)
User: #50
——(NewlD) ______ (New Combo) 41 @ Manager must be Lock: New User with Privileges as identified,
Audit Only: @ #50 00(D) ________ (Combo) created by Master. User should change combination for first use
__(NewlD) ______ (New Combo) 42 @ Combination Length Audit: Event 14 Recorded
must meet requirement
Open + Audit: @ #50 00(ID) ________ (Combo)
__(NewlD) ______ (New Combo) 43 @
Open +TDO: @ #50 00(D) ________ (Combo)
__(NewlD) ______ (New Combo) 45 °
Open + Audit + TDO: @ #50 00(ID) ________
(Combo) __(NewlID) ______ (New Combo) 47 Q
User Enable/ ® #54 __(D) ______ (Combo) __ (User to Master or Manager Keypad: () D)) ) )
Disable: #54 .
ane Change) O @ to Disable User Moncge;rguls\;lc bet Lock: User Enabled/Disabled
@ #54 __(D) ______ (Combo) __(User to rmanagea by Haster Audit: Event 14 Recorded
Change) 1 o to Enable User
Edit User Open Only: ° #55 (D) ______ (Combo) Master or Manager Keypad: N A A o0») 1) )
Privileges: -
#55 __(UsertoChange) 1 @ Manager privileges must | | ock: User Privilege changed as identified
be edited by Master .
AuditOnly: @ #55 __(D) ______ (Combo) Audit: Event 14 Recorded
__(User to Change) 2 @
Open + Audit: @ #55 __(ID) ______ (Combo)
__(User to Change) 3 @
Open+TDO: @ #55 __(ID) ______ (Combo)
__(User to Change) 5 @
Open + Audit + TDO: @ #55 __(ID) ______
(Combo) __(User to Change) 7 O
Delete User: ® #56 __(D) ______ (Combo) __ (User Master or Manager Keypad: () ) () ) ) 0)
#56
o Dl Manager must be Lock: User Deleted
deleted by Master
Audit: Event 14 Recorded
Reset User ® #57 (D) (Combo) Master or Manager Keypad: () () ) ) 0)
Combination: Recaty
#57 —-(DtoReset) ______ (New Combo) Manager must be reset | | gek: User will have new Initial Combination.
——(IDtoReset) ______ (New Combo) @ by Master User should change combination for first use.
Combination Length Audit: Event 14 Recorded
must meet requirement
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Uninstall/Reinstall/Reset Keypad and Lock

The commands below are shown with the ° as the key press for waking the system. When not needed the lock will respond with a short red
flash and low beep signaling that the lock is ignoring that key and waiting for your # command.

Audit Events shown below are not recorded for 701 Models.

Action Command String Requirement Result

Reinstall ®#32__(D) ______ (Combo) @ Open Privilege Required | Keypad: Alternating Red and Green

Keypad: #32 Flashes indicate the same Keypad Model
iﬂs\notgcired, Success indicated with

) o) 1)
Lock: Lock is Installed to Keypad
Audit: Event 17 Recorded

Uninstall o #23 00(D) ________ (Combo) ° Master Only .:,-1)))1)))‘)))

Lock: #23

Lock: Is no longer installed to Keypad, all
settings are maintained

Audit: Event 11 Recorded

Reset Lock: @ #25 00 (ID)

(Combo) @ Master Only Keypad: () () ) ) 4) #)
#25

Lock: Master Combo is reset to 12345678, All
users deleted, All Factory Defaults restored,
Lock will be uninstalled from Keypad

Audit: Event 4 Recorded

GIGIPLDLD)

Install Lock: ° #22 00(D) ________ (Combo) ° Uninstalled: Master Keypad:
#22 Combination has been

changed from default. Lock: Installed
Audit: Event 5 Recorded

LA GARD 700 Series Brochures and Spec Sheets/Broschiiren und Datenblétter:
LA GARD 700 Series Brochure

Support Documents: LA GARD 700 Series All Model Spec Sheet

Installation Manuals/Installationshandbicher LA GARD 700 Series Model 701 Spec Sheet
LA GARD 700 Series Battery Box Installation Box LA GARD 700 Series Model 702 Spec Sheet
LA GARD 700 Series Keypad Installation Guide LA GARD 700 Series Model 703 Spec Sheet
LA GARD 700 Series Multiplexer Installation Box LA GARD 700 Series Model 704 Spec Sheet
LA GARD 700 Series Power Supply Installation Guide LA GARD 700 Series Model 705 Spec Sheet

LA GARD 700 Series Reset Box Installation Box
LA GARD 700 Series Safe Lock Installation Guide
LA GARD 700 Series Alarm Box Installation Guide
LA GARD 700 Series Installation Best Practices

Operation Manuals/Bedienungsanleitungen:
LA GARD 700 Series — System User Guide
LA GARD 700 Series - Software Installation & Registration Guide (EN)
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